This Software and Documentation are provided “as is” and without express or limited warranty of any kind by either MicroStrategy, Inc. or anyone who has been involved in the creation, production, or distribution of the Software or Documentation, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. The entire risk as to the quality and performance of the Software and Documentation is with you. Should the Software or Documentation prove defective, you (and not MicroStrategy, Inc. or anyone else who has been involved with the creation, production, or distribution of the Software or Documentation) assume the entire cost of all necessary servicing, repair, or correction. Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

In no event will MicroStrategy, Inc. or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract warranty, negligence, strict liability for the negligence of indemnity or contribution, the failure of any remedy to achieve its essential purpose, or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy shall not exceed, at the option of MicroStrategy, Inc., either a full refund of the price paid, or replacement of the Software. No oral or written information given expands the liability of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

Copyright © 2000, MicroStrategy Incorporated. All rights reserved.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U.S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at FAR 52.227-19, as applicable. Contractor is MicroStrategy, Inc., 8000 Towers Crescent Drive, Vienna, Virginia 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.


09350800 Published August 2000
Contents

Overview 7

Section I  Analyst Concepts 1

Chapter 1  Report Formats 3
  Grid reports 3
  Graph reports 5
  Design view reports 6
  SQL view reports 6
  To learn about... 6

Chapter 2  Manipulating Report Data 7
  Sorting 7
  Repositioning rows and columns 7
  Adding filters dynamically 8
  Answering prompts 8
  Drilling 8
  Using Outline Mode 9
  Locking row and column headers 10
  Using Auto Styles 10
  Merging headers 11
  Viewing long names 12
  To learn about... 12

Chapter 3  Report Functions 13
  Page-by 13
  Filter details 14
  Subtotals 15
  Data options 15
  Export options 18
  Prompt resolution 18
  Report schedules 19
  To learn about... 19

Section II  Interface 21

Chapter 4  Report Viewer 23
  Report Viewer layout 24
    The display area 24
Contents

The menu bar 25
The toolbar 28

Chapter 5 Prompt Resolution Wizard 31
Prompt Resolution Wizard layout 31

Section III How do I...? 35

Chapter 6 Formats 37
Display a data label for a graph 37
Display a footnote for a graph 37
Display a legend for a graph 37
Display a subtitle for a graph 38
Display a title for a graph 38
Display the Preferences dialog for a graph 38
Format the background of a graph 39
Format the footnote of a graph 39
Format the frame of a graph 39
Format the legend for a graph 40
Format the subtitle of a graph 40
Format the title of a graph 40
Modify the grid appearance before printing 41
Set web options for a graph 44
View a report in design view 44
View a report in graph view 45
View a report in grid view 45
View a report in SQL view 45

Chapter 7 Functions 47
Change the attribute form used in a report 47
Choose a schedule for a report 47
Clear report limits from the Report Editor 48
Clear totals in a report 48
Define subtotals using the Subtotals dialog box 48
Export a report to MS Access 49
Export a report to an MS Excel Worksheet 49
Export a report to an HTML file 50
Export a report to a text file 50
Export a report to MS Word 51
Refresh a report 51
Restore metric defaults 51
Set an attribute to use its default form in a report 51
Set drilling options for a report 52
Set the evaluation order for a report  52
Set the metric formatting properties for a report  53
Set the report limit for a report  53
Show filter details for a report  54
Show pages for a report  54

Chapter 8 Manipulating Report Data  55
Add a filter dynamically to a report  55
Clear the sorts for a report  55
Display outline results for a report  55
Drill on a report  56
Lock report column headers  56
Lock report row headers  56
Merge header cells on a report  56
Move a column to a page in a report  57
Move a column to a row in a report  57
Move a column to the left in a report  57
Move a row to a column in a report  57
Move a row to a page in a report  58
Select a graph type for a graph report  58
Select an auto style for a report  58
Select options for a graph report  59
Select options for a grid report  59
Sort a report  60
View long names in a report  60

Appendixes  61
Available Graph Types 63

Index 93
INTRODUCTION

Overview

As the analyst, you are the user of your company’s business reports, and, in that role, provide information requirements to report designers. These requirements ensure that the desired reports are published for the entire user community.

Once the reports are created and published, you can view and manipulate them, and based on your needs, you may request modifications or additional reports from the report designer.

Organization

This manual is a resource for every task you have to complete, and is divided into three main sections:

• **Concepts**: includes functional descriptions of the product components and features with which you are working.

• **Interface**: contains interface specific information; describes the interfaces you use to view and manipulate reports.

• **How do I...?**: describes the procedures associated with identified tasks; provides answers to questions you may have while using MicroStrategy 7.

Reference materials

Before you begin viewing reports, you should read the *Getting Started* manual, which serves as an introduction to the features and functionality of the MicroStrategy 7 product suite. Getting Started also provides you with the basic terminology and information resources that can help you navigate the software and accompanying documentation.
SECTION I

Analyst Concepts

Topics included in this section:
• Report Formats
• Manipulating Report Data
• Report Functions
CHAPTER 1

Report Formats

MicroStrategy Desktop functions provide a number of ways to display data that has been obtained for analysis. The format you select for viewing a report should depend on

• the purpose for which you intend to use the information
• display features and options for each report format

The report display formats available are design, grid, graph, and SQL. Of these, the formats you are likely to use most often are grid and graph. The information that follows, which addresses each of these display formats, can help you select the best one for your purposes.

Grid reports

As a rule, grid reports consist of rows and columns, each row or column having a heading, each representing an attribute, a consolidation, a custom group, or a metric. This report format is characterized by its capability to display in a flexible, easy-to-modify level of detail, data associated with

• hierarchies: primary criteria for selecting template components. Commonly used hierarchies include Geography, Time, Product, and Customer.
• attributes: hierarchy components. Geography may consist of the attributes Region, State, City, and so on.
• consolidations: groupings of same-attribute elements that accommodate inter-row arithmetic operations
• custom groups: special filters that can be placed on a template. They contain ordered collections of elements.
• metrics: analytical calculations performed against template or filter data
• prompts: conditions applied to one or more attributes, filters, or metrics on a report

The following figure shows the format of a typical grid report.
Grids have certain properties with which you should be familiar so as to maximize report utilization.

- **Banding** enables the grouping of rows or columns by color to enhance readability and, in some cases, identify attributes or attribute elements meeting certain criteria.

- **Data-level control** enables
  - total and subtotal calculations
  - access to levels of information above or below the one being displayed
  - expansion of attribute conditions
  - display of data in outline fashion

For example, if a grid shows total sales for an item at the district level, data-level control allows you to break down the information to view totals at the city or store level.

- Display control functions allow you to determine physical conditions for the grid, such as colors, column width, and print conditions. This property allows you to select a color for a banded set of rows, for example.

- Data-export definition allows you to specify conditions for sending data to other applications. Using this property you could, for example, send data to a spreadsheet or a word processor.

<table>
<thead>
<tr>
<th>Row heading</th>
<th>Column 1 heading</th>
<th>Column 2 heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row 1 heading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 2 heading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 3 heading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 4 heading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 5 heading</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Graph reports

Typically, a graph report shows numerical values as points, lines, bars, or circles, and non-numerical data as reference axes. Thus, when a grid report is converted to graphic format, the various cells in the grid give shape to the graph itself, while the column and row headings become the axes of the graph.

In a MicroStrategy Desktop environment, graph reports provide a number of options for viewing and analyzing data. Although not all reports can be displayed in every graph type that MicroStrategy Desktop makes available, any report can be shown in several ways. Choices for graph display include

- vertical or horizontal bars
- vertical or horizontal lines
- integrated or modular pie displays
- histograms
- a variety of special-purpose displays

Each of the graph types listed includes several variations, available as menu options, that further refine data display. The figure that follows shows how the data on a grid report such as the one shown on page 3 might be displayed as a graph. For a display sample of the graph types available, see the appendix Available Graph Types in this information unit.
Design view reports

**Note:** Access to the Design option as a report format is frequently restricted. If you wish to have access to this format and find that the option is not available, consult your administrator.

The report design option allows you to view the templates and filters that were used to create a given report. By selecting any existing report and then choosing this option, you can view and modify the basic components of a report. Note, however, that saving your changes requires the appropriate authorization.

The design option also allows you to either select or define both a template and a filter, the two basic components of a report. In other words, with this option you can create a report. Report creation is outside the scope of this document; for details on the subject, please refer to the information units addressing Report Designer tasks.

SQL view reports

You use the SQL view of a report when you want to see the SQL statements associated with that report. For any report, the SQL view shows:

- attribute elements included as part of the display
- tables in the database that provide row and column data
- types of aggregation performed on the data selected
- conditions applied to the data before it is displayed

To learn about...

...report-format-related tasks you can perform using MicroStrategy Desktop, see the report-format-related information in the **How Do I...?** topic

Report Formats

...report interfaces, see the information in

Report Interfaces
CHAPTER 2

Manipulating Report Data

MicroStrategy Desktop functions provide you the flexibility to change dynamically the information shown on a report. By applying certain actions to the data displayed, you can narrow or widen the scope of intelligence provided, and adjust the output to answer specific questions. The menu options that MicroStrategy Desktop makes available for report manipulation allow you to

- sort data according to selected criteria
- rotate rows or columns
- dynamically apply a filter
- resolve prompts (to obtain specific data)
- drill (to a higher, lower, or parallel level) through data displayed
- group or combine headers for display

The information that follows addresses each of these capabilities.

Sorting

Sorting allows you to see the data on a specific column displayed in either ascending or descending order on a grid report.

Repositioning rows and columns

MicroStrategy Desktop provides functions that allow you to change dynamically the relative position of a row or a column in a grid report. With this function you can

- change a row into a column
- change a column into a row
- change the relative order of a row
- change the relative order of a column
Adding filters dynamically

MicroStrategy Desktop allows you to modify the information displayed on a report by dynamically adding a filter or a template heading to the grid. This capability is also known as surfing. When you apply this function, the report is automatically regenerated and redisplayed showing the updated data.

Depending on how you select a filter to be added to a report, you can either add that filter to one already applied, or replace the existing filter with the one you have just selected. For example, if you have a displayed report that includes the filter “1997” and you select to add the filter “USA” to the report, the result of your selection could be either “(all) USA (in) 1997” (the new filter has been added to the existing one) or “(all) USA, (all years)” (the new filter has replaced the existing one).

Answering prompts

Prompts are conditions or qualifications that can be defined for application to one or more reports. When you choose to answer a prompt, the report is redisplayed reflecting the modified conditions.

For additional information on prompts and their use, see Prompt Resolution in the chapter “Report Functions.”

Drilling

Drilling allows you to look at specific data at levels other than that of the originally displayed grid or graph. With this function, you can drill down, up, or across attributes displayed in a report.

**Drilling down** allows access to data at progressively lower levels within a hierarchy (for example, if the attribute level displayed for geography is region, drilling down would allow you to see information at the state, city, or store level).

Similarly, you can broaden the scope of information by **drilling up**, to levels of data increasing higher within a hierarchy (for example, if time is shown at the date level, drilling up could display this hierarchy at the week, month, or quarter level).

Additionally, you can use the **free drilling** capability to drill from one attribute level to another, either within a hierarchy or across hierarchies. In other words, using the free drilling function, you can drill in any
direction without having to reselect a drilling mode to change direction. This capability allows you to find specific element values and same-level equivalence among hierarchies.

**Note:** Filters and metrics apply equally to all data levels in a report; therefore, display conditions and restrictions remain unchanged for all attribute levels when drilling is applied (for example, if there is a “1998” filter applied to a report, that filter will be applied to views showing any time level -- week, month, quarter -- on that report).

### Using Outline Mode

Outline Mode allows indented grouping of related attributes, much as do heading levels in a document outline. This function is particularly useful in instances in which the information displayed would otherwise involve repetitive entries, as in the case of a grid showing sales by division, each division broken down by region. The figures that follow show how the data is typically displayed on a grid, and how it appears once Outline Mode is activated.

![Typical grid report](image-url)
When Outline Mode is activated, totals and subtotals are displayed above aggregated attributes. To activate Outline Mode, you must define at least one metric for the report.

### Locking row and column headers

MicroStrategy Desktop allows you to “lock” row and column headers on a grid report. This function enables scrolling back and forth, both horizontally and vertically, without losing sight of the row or column names. This property is particularly advantageous when you want to view information that spans more rows or columns than can be displayed at one time.

### Using Auto Styles

The Auto Styles option allows you to select from among several presentation styles for report display, each providing a different format, color scheme, and font.
Merging headers

You can merge multiple row headers that are identical into one header. For example, a report may associate sales by merchandise type, methods of payment, and total amount sold. If there is a row for each merchandise type for each method of payment, all headers corresponding to a given type can be merged into one. The figures that follow illustrate how this function works.

<table>
<thead>
<tr>
<th>Year</th>
<th>Country</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Payment Method</th>
<th>Metrics</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics</td>
<td>Visa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>Amex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>Check</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>MC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Food</td>
<td>Visa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Food</td>
<td>Amex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Food</td>
<td>Check</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Food</td>
<td>MC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gifts</td>
<td>Visa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gifts</td>
<td>Amex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gifts</td>
<td>Check</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gifts</td>
<td>MC</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Report with multiple identical headers
Viewing long names

Format limitations sometimes make the full display of attribute forms on column or row headings unfeasible or impractical. For such cases, you can elect to view “long names” for columns or rows when desired. This function allows you to see the name of the attribute form as it appears on the template used for the report.

To learn about...

...report-data-manipulation tasks you can perform using MicroStrategy Desktop, see the How do I section in this guide....report interfaces, see the Interface section in this guide.
You can use a set of unique report-associated functions to facilitate the customizing of report contents.

Report functions with which you should be familiar include:

- page-by
- filter details
- totals and subtotals
- data options
- export options
- prompt resolution

The information that follows provides a description of each item on this list.

### Page-by

The page-by function allows you dynamically to select report components as criteria for analysis. The grid that results from this selection is called a page of the original report. You can save a page you have created, and subsequently display it and manipulate it as you would any other report. Criteria you can use to create page-by reports include:

- hierarchies
- attributes
- metrics
- consolidations
- custom groups
- object prompts

By allowing the use of different criteria to show information, pages provide an added level of capability for data manipulation and display. Using a report that shows customer-related information, for example, you
could create a page showing specific data, either for all customers or for a
customer group meeting certain criteria. The figures that follow illustrate
the function.

<table>
<thead>
<tr>
<th>Customer Name</th>
<th>Customer State</th>
<th>Customer Region</th>
<th>additional customer data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer1 Name</td>
<td>Customer1 State</td>
<td>Customer1 Region</td>
<td>xxxxxxxxxxxxxxxx</td>
</tr>
<tr>
<td>Customer2 Name</td>
<td>Customer2 State</td>
<td>Customer2 Region</td>
<td>xxxxxxxxxxxxxxxx</td>
</tr>
<tr>
<td>Customer3 Name</td>
<td>Customer3 State</td>
<td>Customer3 Region</td>
<td>xxxxxxxxxxxxxxxx</td>
</tr>
<tr>
<td>Customer4 Name</td>
<td>Customer4 State</td>
<td>Customer4 Region</td>
<td>xxxxxxxxxxxxxxxx</td>
</tr>
<tr>
<td>Customer5 Name</td>
<td>Customer5 State</td>
<td>Customer5 Region</td>
<td>xxxxxxxxxxxxxxxx</td>
</tr>
</tbody>
</table>

Report showing customer-related data

Page showing data for a specific customer

**Filter details**

While a report is displayed, you can view the filters that have been applied
to the template for that report.
Subtotals

Totaling is among the properties available for viewing the information in a report. Subtotals reflect accumulations at selected attribute levels, and can be applied dynamically to any report displayed.

Data options

You can use available functions that allow you to set additional conditions on the data displayed.

Limits

Limits are maximum and minimum values you can specify for a given report metric. They can denote

- the highest and lowest values in independent quantity ranges
- the end points of selected portions of a whole (such as the highest and lowest values for a given percentage range, or the top or bottom ten items on a best-seller list)

Metric limits can be defined in terms of the following:

- value is expressed as greater than a given value (>), greater than or equal to a given value (≥), less than a given value (<), less than or equal to a given value (≤), or between two given values (< >)—for example, greater than 5 transactions; less than or equal to 2.75m; between.3 and 1.2 seconds.
- rank is expressed as the top ordered range within a set of values, the bottom ordered range within a set of values, exactly (fixed value within a set of values), or between two values within a set of values—for example, the top ten selling items in a store, the bottom 5 performers in a region, the third highest score in a set of test results.
- percent can be the top x percent of a whole, the bottom x percent of a whole, or between two percentage values related to a whole—for example, buyers representing the top ten percent of a customer base, the list of stores that produce between fifteen and twenty-five percent of the total revenue.
**Join types**

Join specification serves to place conditions on rows selected for display.

- An **inner join** includes only data that are common across all metrics in a report. This is the default value for display.

  For example, to show sales and budget information for all regions, inner joins for both Sales and Budget would yield a report showing only those regions for which there is both sales and budget information, as illustrated in the figure that follows.

  Because there is no budget data for the North region, and no sales data for the West region, these two regions would not be included when the report is displayed.

- An **outer join** includes data that apply to every metric in a report.

  For example, to show sales and budget information for all regions, if Sales has an outer join and Budget has an inner join, the combination would yield all those regions for which there is sales and budget information, and would also include all rows for sales, as illustrated in the figure that follows.
Because budget has an inner join and there is no budget data for the North region, that region would not be included when the report is displayed.

If both Sales and Budget have outer joins, all regions would be displayed on the report, whether or not there is sales or budget data, as illustrated in the figure that follows.

### Evaluation order

The order in which data is calculated has a bearing on the results to be displayed. By using evaluation order settings, you can control the order in which consolidations, certain metrics, metric limits, and subtotals are calculated and resolved for a given report.
**Metric aliases**

In certain cases, you may want to change the name of a metric for report display purposes. By selecting an alias for that metric, you can have it displayed under a different name without actually changing its title in the definition.

**Drilling**

Drilling allows users to view selected data at levels either higher or lower than that shown on the report displayed. By using drilling capabilities, you can:

- enable or disable the drilling.
- specify whether drilling is to be enabled in all directions or down only.
- determine whether to keep the level immediately above (the parent) in the hierarchy of the attribute on which you are drilling.

**Export options**

You can select the destination and conditions under which to export a report. Options associated with this capability allow exporting to

- Excel worksheets
- Word documents
- Access databases
- text files
- HTML files

Each of these export destination types provides a set of choices for display as well as advanced options for formatting and error handling.

**Prompt resolution**

Prompts provide the means to apply certain conditions to the metrics, attributes or attribute elements in a report. By resolving a prompt that has been defined, you can modify the information displayed. Data modification, in such cases, is contingent upon the way in which you choose to answer the prompt. To resolve a prompt, you can

- use the default value set when the prompt was defined
- enter a valid value for the prompt
• decline the prompt (in which case the returned results either ignore the prompt or reflect the value used for the prompt when last applied)

**Note:** In certain cases, declining the prompt is not an option; you must answer the prompt before you can continue.

---

## Report schedules

Although scheduling reports is not part of the report function set itself, it is, nonetheless, a concept with which you should be familiar if you view and manipulate reports frequently. As a rule, there is a variety of schedules from which you can select to run a given report (if the schedule on which you wish to have the report generated is not among the choices available, you can request that your administrator create that schedule for your use).

Report schedules can be driven either by **time** or by an **event**. Here are a few examples of the criteria you can use to schedule report generation:

- every three hours during a 48-hour period (time-driven schedule)
- every Sunday at midnight (time-driven schedule)
- the third day of every month (time-driven schedule).
- every time a given file is updated in the database (event-driven schedule)

---

### To learn about...

...report-function tasks you can perform, see this How do I...? topic:

Report Functions

...report interfaces, see this topic:

Report Interfaces
Topics included in this section:
- Report Viewer
- Prompt Resolution Wizard
Report Viewer

What is it?

Report Viewer is a window that MicroStrategy 7 makes available to display, format, and manipulate existing reports.

How can I access it?

You can access Report Viewer by opening any directory containing reports and selecting an item from that directory.

What can I do with it?

You can use Report Viewer menus and associated options to

- select and display a report
- change the display mode of a report
- see what filter(s) have been used
- view and modify subtotal information
- answer prompts
- apply banding to group-related rows
- select display conditions (such as color, column width, and so on)
- change sorting criteria
- rotate rows or columns
- apply new or additional filters
- drill in any direction, either within an attribute or across attributes
- group headings in outline fashion
- lock the display of column or row headings
- select display styles
- merge multiple headings into one
- view attribute forms
What should I know before I use it?

Before you use Report Viewer, you should familiarize yourself with

• the basic components necessary to build of a report
• the function of
  ◊ templates
  ◊ filters
  ◊ metrics
• the uses of grids and various types of graphs
• the purpose of prompts

Report Viewer layout

Report Viewer is a window in which reports are displayed and manipulated to serve specific purposes. The Report Viewer window has three primary areas:

• a display area, where a report selected is shown
• a menu bar that, in addition to standard Windows NT main-menu options includes menus and menu options addressing unique Report Viewer functions
• a toolbar from which you can select directly the Report Viewer options most frequently needed

The information that follows addresses each of these window areas.

The display area

The display area is divided into three portions:

• a Filter Details window, which shows a list of all the filters that apply to the report being displayed
• a window where a report requested is displayed
• a status bar that shows
  ◊ execution status (either executing or complete)
  ◊ execution time (the amount of time it takes to generate the report)
  ◊ the number of rows and columns in the report
The menu bar

In addition to functions common to most Windows NT applications (File, Edit, Help), the Report Viewer menu bar includes

• a View option that, although part of the common menu bar items in Windows NT applications, provides access to unique Report Viewer functions

• two unique Report Viewer options, Data and Grid, which provide access to MicroStrategy Desktop capabilities specifically intended to facilitate report viewing and manipulation

The tables that follow describe specific Report Viewer functions available through the menus under View, Data, and Grid.

View menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>• Design View</td>
<td>Opens the Report Editor dialog box, where you can view and modify report template, filters, and metrics.</td>
</tr>
<tr>
<td>• Grid View</td>
<td>Displays a report in grid mode.</td>
</tr>
<tr>
<td>• Graph View</td>
<td>Displays a report as a bar graph (the default graph format)</td>
</tr>
<tr>
<td>• SQL View</td>
<td>Displays the SQL program for a report.</td>
</tr>
<tr>
<td>• Run/Refresh Report</td>
<td>Displays or redisplays a report reflecting the latest definitions for the various report components.</td>
</tr>
<tr>
<td>• Show Pages</td>
<td>Opens the Pages window on a grid report, where you can drop attributes or metrics for page creation.</td>
</tr>
<tr>
<td>• Show Filter Details</td>
<td>Opens the Filter Details window on a grid report, where you can view filter definitions.</td>
</tr>
</tbody>
</table>

Data menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>• Sort Ascending</td>
<td>Rearranges the contents of a selected column so that items appear in ascending order.</td>
</tr>
<tr>
<td>• Sort Descending</td>
<td>Rearranges the contents of a selected column so that items appear in descending order.</td>
</tr>
<tr>
<td>• Clear Sorts</td>
<td>Restores the content of the report to the way it was before the Sort option was applied.</td>
</tr>
</tbody>
</table>
### Option | Definition
--- | ---
• Advanced Sorting | Opens the **Sorting** dialog box, where you can enter the additional criteria necessary for row or column sorting.
• Subtotals | Opens the **Subtotals** dialog box, where you can select, from the list provided, the type of aggregation to apply to the report.
• Attribute Display | Opens the **Attribute Display** dialog box, where you can select the display form to apply to an attribute selected.
• Report Data Options | Opens the **Report Data Options** dialog box, where you can view (and, if you so desire, reset) the limits, join types, evaluation order, and drilling options of a report.
• VLDB Properties | Opens the **VLDB Properties** dialog box, where you can view the settings for report components (data types, joins, metrics, and so on), and, where applicable, the SQL statements associated with a given component.
• Export Options | Displays a menu showing all the destinations to and formats in which a report can be exported (Excel worksheets, MS Word documents, Access databases, text files, HTML files).
• Export To | Allows specification of a destination for a report to be exported.

### Grid menu options

| Option | Definition |
--- | ---
Grid | Default option for report display
• Edit | Opens the editor corresponding to an object that has been selected.
• Move to Row | Converts a column into a row in a displayed report.
• Move to Column | Converts a row into a column in a displayed report.
• Move to Page | Moves a row or column selected to the **Page By** window.
• Move Left | Allows horizontal scrolling to the left.
• Move Right | Allows horizontal scrolling to the right.
• Options | Displays the **Grid Options** window, where you can select banding, metric header, and metric value options.
• Display Outline Results | Redisplays a grid report in outline mode.
The Gallery menu option is activated when you select to view a report in graph form. The choices within this menu provide access to all the graph types available for viewing from any graph report.
The toolbar

Report Viewer choices most frequently used, available as options through one of the menu bar items, are replicated on the toolbar, where they are accessible by means of representative icons.

Common toolbar options

The following Report Viewer toolbar options are common to two or more available report types:

• **Report View**: provides access to a drop-down menu that shows the various options for viewing a report. Choices are
  ◊ Design View (default mode for this menu)
  ◊ Grid View
  ◊ Graph View
  ◊ SQL View

  When you click a Report Viewer option from this menu, the report is displayed in the mode you have selected.

---

**Note:** Unless you have the authority to log in as an administrator, the Design View option may not be available for your use. In some cases, also, availability may be limited—you would be able to create and view reports, but not to save them.

---

• **Run Report**: allows you to redisplay a report reflecting new data.

• **View Pages**: provides a Report Viewer window in which you can drop (by clicking and dragging) report components selected as criteria for page creation.

• **Sort Ascending**: re-sorts a selected row or column in seasoning order

• **Sort Descending**: re-sorts a selected row or column in descending.

• **Subtotals**: allows you to apply aggregations to existing data on a report.

  Subtotals provides the Subtotals dialog box, which consists of
  ◊ a **Definition** window from which you can select the type of aggregation to be applied
  ◊ a **Display Options** window in which you can specify the position, by column and row, for subtotal information display

  The Subtotals dialog box also includes an **Advanced** button that allows you to customize subtotal information, and a **Clear All** button that allows you to discard current subtotal data.
Toolbar options unique to grid reports

The following toolbar options are unique to grid reports:

• **Move to Row, Move to Column**: used to convert a selected row to a column or vice-versa, this function provides a dynamic way to modify the layout of a report.

• **Move to Page**: used to access the list of Page By instances for a report.

• **Move Right, Move Left**: when the number of rows or columns in a report exceeds the space available for Report Viewer display, this function allows you to scroll, either up-and-down or left-and-right.

• **Display Outline Results**: used when grouping together related rows or columns is desirable; partitions grid headers into logical categories and subcategories.

• **Auto Styles**: used when different display characteristics are desired; allows style selection from a drop-down menu.

• **Drill**: when selected, provides the Drill dialog box, which contains
  ◊ a window providing a drop-down menu from which you can select an attribute or metric on which to drill (for example, you could drill on the attribute Year, on the attribute Country, and so on)
  ◊ a window showing the drill options available for the attribute or metric selected (Up, Down, or Other Directions)
  ◊ a check box on which you can specify whether you wish to retain display of the level from which the drill is initiated (the “parent” level)

Toolbar options unique to graph reports

The following toolbar options are unique to graph reports:

• **Select a Graph type**: used to select the graph that best suits a specific display purpose, this selection shows each graph report type, in succession, when clicked.

• **Show Legends**: displays or hides the meaning of colors as they apply to elements in a graph.

• **Set Series by Row**: groups graph elements according to grid rows.

• **Set Series by Column**: groups graph elements according to grid columns.

• **Select Font Type**: allows you to select a font for a given report component.

• **Select Font Size**: allows you to select a type size for a given report component.

• **Select Font Character Set**: allows you to select a character set (for example, French, Swedish, or Korean) for the report.
For information on the use of Report Viewer options to view, format, and modify reports, refer to the How Do I section in this guide.
Prompt Resolution Wizard

What is it?

Prompt Resolution Wizard is a dialog box that allows you to answer prompts when you select for display reports that include them.

How can I access it?

The system displays and allows you to access Prompt Resolution Wizard automatically whenever you select a report that contains a prompt.

For information on the use of Prompt Resolution Wizard, refer to the How Do I...? section in this guide.

What can I do with it?

You can use Prompt Resolution Wizard to answer a prompt that has been defined for a report.

What should I know before I use it?

Before you use Prompt Resolution Wizard, you should familiarize yourself with

- the effect that prompts have when applied to a report
- prompt types available, and their use
- the effect of answering or declining a prompt

Prompt Resolution Wizard layout

Prompt Resolution Wizard is a dialog box that is displayed when you select a report for which a prompt has been defined. The layout of this dialog box varies with the type of prompt that has been created for the report, although certain elements remain constant for all cases. Common elements are
• a display area across the top of the page, showing the prompt type, the attribute or attribute element(s) on which the qualification is applied, and other pertinent data such as minimum and maximum values selected

• the Help button on the bottom-left corner of the page

• Cancel, Back, Next, and Finish option buttons on the bottom-right corner of the page

• the Execution Time display on the bottom right-corner of the page, under the option button

The following paragraphs describe the general Prompt Resolution Wizard layout for each prompt type.

Resolving filter definition prompts: Attribute Qualification prompt layout

The layout for this type of prompt consists of two major areas:

• **Definition**, which includes
  ◊ a description of the attribute form chosen for the prompt (for example, if the attribute selected is “Customer” and the form selected is “ID,” the form description would read *Customer ID Exactly <Value>*)
  ◊ instructions for selecting, if desired, a different qualification form when answering the prompt.

• **Attribute Qualification**, which consists of
  ◊ an **Attribute** box, where you can enter an attribute for qualification (for example, “Customer”)
  ◊ a **Form** box, where you can enter the form on which to qualify (for example, “ID”)
  ◊ an **Operator** box, where you can enter the limits or conditions of the attribute form (for example, “Exactly”).

Resolving filter definition prompts: Element List prompt layout

The layout for Element List prompts consists of two major areas:

• on the left side of the page, a display box showing the list of attribute elements available for qualification

• on the right side of the page, a display box where you can place the attribute elements you choose (from the list on the right) for qualification
To apply a prompt of this type, you select elements from the list on the left and transfer them to the area on the right by means of the transfer arrows (> and <) located in the center of the Prompt Resolution Wizard page.

For example, if the prompt consists of all the elements in “Customer Region,” and the page shows the list “Central, England, France, Germany, Mid-Atlantic, North-East, North-West, South, South-East, and South-West,” to qualify on all European sites you would use the transfer arrows to move “England,” “France,” and “Germany” to the right side of the page.

**Note:** With this type of prompt, there may be limits (minimum, maximum, or both) to the number of attribute elements on which you can qualify. If that is the case, these limits are shown in the display area across the top of the page.

---

**Resolving filter definition prompts: All Attributes in a Hierarchy prompt layout**

The layout for this type of prompt consists of four areas:

- a display box from which you can select a hierarchy within the report
- an object browser box where you can search for applicable hierarchies in a project
- on the left side of the page, a display box showing name, type, and date of the latest modification for attributes in the hierarchy you have selected
- on the right side of the page, a display box where you can enter additional qualifications

For example, if you select “Time” as a hierarchy on which to qualify, the display box on the left side of the page may show “Month of the Year” and “Year” as the attributes in that hierarchy.

**Resolving filter definition prompts: Metric Qualification prompt layout**

The layout for this type of prompt consists of two major areas:

- a **Definition** box showing the definition of the metric selected and instructions for metric qualification
- a **Metric Qualification** box where you can either enter the name of a metric for qualification or select one from a list.
Resolving Object prompts: prompt layout

The layout for this type of prompt consists of two major areas:

• on the left side of the page, a display box showing the list of objects available for qualification
• on the right side of the page, a display box where you can place the objects you select (from the list on the right) for qualification.

To apply this prompt, you select objects from the list on the left and transfer them to the area on the right using transfer arrows ( > and < ) located in the center of the Prompt Resolution Wizard page.

For example, if the prompt consists of Sales objects, and the page shows the list Avg Dollar Sales per Order, Max Dollar Sales per Order, Min Dollar Sales per Order, to qualify on the average dollar sales amount per order you use the transfer arrows to move Avg Dollar Sales per Order to the right side of the page.

Note: Whenever there are limits to the number of objects on which you can qualify, they are shown in the display area across the top of the page.
SECTION III

How do I...?

Topics included in this section:
• Formats
• Manipulating Report Data
• Functions
Formats

Display a data label for a graph

Steps
1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Display, then select Data Label. A check mark appears next to Data Label, indicating that it is displayed on the graph.

Display a footnote for a graph

Steps
1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Display, then select Footnote. A check mark appears next to Footnote indicating it is displayed on the graph.

Display a legend for a graph

Steps
1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the **Graph** menu, choose **Display**, then select **Legend**. A check mark appears next to **Legend** indicating it is displayed on the graph.

**Display a subtitle for a graph**

**Steps**

1. Run a report.
2. If the report is not already displayed in graph mode, from the **View** menu, choose **Graph View**.
3. From the **Graph** menu, choose **Display**, then select **Subtitle**. A check mark appears next to **Subtitle** indicating it is displayed on the graph.

**Display a title for a graph**

**Steps**

1. Run a report.
2. If the report is not already displayed in graph mode, from the **View** menu, choose **Graph View**.
3. From the **Graph** menu, choose **Display**, then select **Title**. A check mark appears next to **Title** indicating it is displayed on the graph.

**Display the Preferences dialog for a graph**

**Steps**

1. Run a report.
2. On the report toolbar, set the **View** icon menu to **Graph View**. The report is displayed as a graph.
3. Select **Graph** on the menu bar for the report. The **Graph** drop-down menu is displayed.
4. Select **Preferences** from the **Graph** drop-down menu.
Format the background of a graph

Steps

1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Formatting, then select Background. The Formatting dialog box opens to the Fill tab.

From this dialog box you can format the color, pattern, gradient, texture, or picture. Format as desired and click OK to return to the graph.

Format the footnote of a graph

This procedure assumes that the footnote is displayed. If it is not, refer to the how do I entitled Display a footnote for a graph for instructions.

Steps

1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Formatting, then select Footnote. The Formatting dialog box opens to the Font tab.

From this dialog box you can format the color, font, size, style, alignment and box. Format as desired and click OK to return to the graph.

Format the frame of a graph

Steps

1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Formatting, then select Frame. The Formatting dialog box opens to the Fill tab.

From this dialog box you can format the color, pattern, gradient, texture, or picture. Format as desired and click OK to return to the graph.
Format the legend for a graph

Steps
1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Formatting, then select Legend. The Formatting dialog box opens to the Font tab.
From this dialog box you can format the color, font, size, style, alignment and box. Format as desired and click OK to return to the graph.

Format the subtitle of a graph

This procedure assumes that the footnote is displayed. If it is not, refer to Display a subtitle for a graph for instructions.

Steps
1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Formatting, then select Subtitle. The Formatting dialog box opens to the Font tab.
From this dialog box you can format the color, font, size, style, alignment and box. Format as desired and click OK to return to the graph.

Format the title of a graph

This procedure assumes that the footnote is displayed. If it is not, refer to Display a title for a graph for instructions.

Steps
1. Run a report.
2. If the report is not already displayed in graph mode, from the View menu, choose Graph View.
3. From the Graph menu, choose Formatting, then select Title. The Formatting dialog box opens to the Font tab.
From this dialog box you can format the color, font, size, style, alignment and box. Format as desired and click **OK** to return to the graph.

### Modify the grid appearance before printing

**Steps**

1. Run a report.
2. From the **File** menu, choose **Page Setup**.
3. The following buttons appear on each tab in the **Page Setup** window:
   - Print: Opens the **Print** window.
   - Print Preview: Refer to the next series of steps.
   - Options: Opens a window in which you can view and configure the advanced settings for the selected printer.
4. On the **Page** tab, your options are as follows:
   - Orientation: Select either Portrait or Landscape. The default is Portrait.
   - Scaling: Your options are as follows:
     - “**Adjust to x% normal size**”: Scales the report by a percentage of its original size, from a minimum of 10% to a maximum of 400%. The default is 100%.
     - “**Fit to x page(s) wide by x page(s) tall**”: Scales the report to fit to a certain number of pages horizontally by a certain number of pages vertically.
   - Page Numbering: This option is used only with a header or footer that displays page numbers. It numbers the pages either automatically or starting with a page number that you specify. The default is Automatic, which starts with 1 and increases sequentially in increments of one.
5. On the **Margin** tab, your options are as follows:
   - Center on Page: Select Horizontally, Vertically, or both. If neither option is selected, the report is positioned at the top left corner of the page.
   - Margins: The default page margins (Top, Left, Right, and Bottom) are all set to one inch. You can change some, all, or none of these margins as desired. These margins do not affect the placement of the header and footer.
6. On the **Header/Footer** tab, your options are as follows:
   - **Edit**: You can specify formatting options for both a header and a footer if desired. In order to simplify the visual presentation of the window, only the header or the footer options are shown (depending upon which one is currently selected).
   - **Line Width**: Select the width of the line that appears beneath the header or above the footer (depending upon which one is currently selected). Your choices are
     - None
     - Thin
     - Thick
   - In the Header or Footer section are the following text boxes that correspond to a specific portion of the header or footer:
     - **Left Section**: Text is left-justified with respect to the width of the page.
     - **Center Section**: Text is centered with respect to the width of the page.
     - **Right Section**: Text is right-justified with respect to the width of the page.

At the bottom of this section is a list that contains up to 15 of the most recently used lines of custom text, as well as some lines that have been predefined. When more than one text box is used, the text for each box is separated by a bar.

Wordwrap occurs within each text box whenever two or more boxes are used. If only one of the text boxes is used, wordwrap occurs only if the length of the text exceeds the width of the page.

- The toolbar enables you to create custom headers and footers easily. Each button is described in the table that follows this series of steps.

7. On the **Grid** or **Graph** tab, (tab name changes based on what view your report is saved in) your options are as follows:
   - **Page Fields**: This option is available only when a report that has one or more page field items is being printed. Your options are as follows:
     - **Displayed Page Field**: Only the information for the currently displayed page field item(s) of the report is printed. This is the default.
     - **Expand All Page Fields**: All pages of the report are printed. If the report has more than 10 attribute elements (for example, if you page by the Week attribute for an entire year of data), a warning message asks you to confirm that you want to print all of the pages of the report.
For either of these options, you can enable or disable the Show Page Field Titles option.

◊ **Print on Each Page**: Select Row Headings, Column Headings, or both. For reports that span multiple pages, these options control whether the row and/or column headers are to be included on every page.

◊ **Print**: You can enable either, both, or neither of the following options:
  - **Gridlines**: If enabled, this option displays gridlines in the printout.
  - **Black and White**: If enabled, this option allows you to print in black and white on a color printer.

◊ **Page Ordering**: When a report spans multiple pages horizontally and vertically, you can choose the order in which the pages are printed. Your options are as follows:
  - **Down, then Over**: One vertical series of pages is printed before moving to the top of the next vertical series of pages to be printed. This is the default.
  - **Over, then Down**: One horizontal series of pages is printed before moving to the beginning of the next horizontal series of pages to be printed.

---

**Page Setup window, Header/Footer tab**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose font</td>
<td>Opens a standard font selection window, which enables you to make changes to the currently selected text. If no text is selected, the changes are used as the default for the Header/Footer tab.</td>
</tr>
<tr>
<td>Insert page number</td>
<td>Inserts at the cursor location a placeholder that will be replaced by the current page number when printed.</td>
</tr>
<tr>
<td>Insert number of pages</td>
<td>Inserts at the cursor location a placeholder that will be replaced by the total number of pages when printed.</td>
</tr>
<tr>
<td>Insert date</td>
<td>Inserts at the cursor location a placeholder that will be replaced by the current date when printed.</td>
</tr>
<tr>
<td>Insert time</td>
<td>Inserts at the cursor location a placeholder that will be replaced by the current time when printed.</td>
</tr>
<tr>
<td>Insert project name</td>
<td>Inserts at the cursor location the name of the current project.</td>
</tr>
<tr>
<td>Insert report name</td>
<td>Inserts at the cursor location a placeholder that will be replaced by the current report name when printed.</td>
</tr>
<tr>
<td>Insert template name</td>
<td>Inserts at the cursor location a placeholder that will be replaced by the current template name when printed.</td>
</tr>
</tbody>
</table>
Set web options for a graph

**Steps**

1. Run a report.

2. On the report toolbar, set the View icon menu to Graph View. The report is displayed as a graph.

3. Select Graph on the menu bar for the report. The Graph drop-down menu is displayed.

4. Select Preferences from the Graph drop-down menu. The Graph Options dialog box opens.

5. Select the Web Display tab. The system displays the dialog box on which you can specify
   - types of graph display to be allowed for the report
   - whether dimensions are to be saved when the report is closed
   - width and height of the graph in pixels

6. Click OK.

View a report in design view

**Steps**

1. Run a report.

2. From the report viewer View menu, choose Design View. The Report Editor opens.
View a report in graph view

Steps
1. Run a report.
2. From the report viewer View menu, choose Graph View. The report changes to the default graph view.

View a report in grid view

Steps
1. Run a report.
2. From the report viewer View menu, choose Grid View.

View a report in SQL view

Steps
1. Run a report.
2. From the report viewer View menu, choose SQL View. You can now see the SQL generated for the report.
CHAPTER 7

Functions

Change the attribute form used in a report

Steps

1. Run a report. The Report Viewer opens and the report is run.

2. From the Data menu, choose Attribute Display. The Attribute Display dialog box opens.

3. From the Attribute box, choose the attribute whose form you wish to change.

4. Change the attribute form used in the report:
   ◊ To use the attribute’s default forms, select Use the attribute’s default display settings. The Available forms and Displayed forms boxes become disabled.
   ◊ To select a different form, select Use the following attribute forms. In the list of Available forms, select the desired form and click > to add the form to the list of Displayed forms.
   ◊ To remove a form from the list of Displayed forms, select the form and click <.
   ◊ To change the order in which the forms appear in the report, select the form under Displayed forms and click the up or down arrow.

5. When satisfied, click OK. The report is reexecuted and the new forms appear on the report in the order in which you placed them.

Choose a schedule for a report

Steps

1. Locate the report you wish to schedule.

2. Right-click the report and select Properties. The Properties dialog box opens.

3. On the Scheduling tab, select the appropriate check boxes.
4. Click OK.

Tips

• When a scheduled report runs, a message appears in the History folder. Double-clicking the message retrieves the report or, if the report failed, the error message.
• A report can be associated with more than one schedule.

Clear report limits from the Report Editor

Steps
1. Open an existing report in the Report Editor.
2. From the Data menu choose Report Data Options.
3. On the Report Limit tab click Clear Report Limit. All listed limits are cleared.
4. Click OK.

Clear totals in a report

Steps
1. Open the report in the Report Editor.
2. From the Data menu, choose Subtotals. The Subtotals dialog box opens.
3. Click Clear All to clear all totals.
4. Click OK.

Define subtotals using the Subtotals dialog box

Steps
1. Run a report.
2. From the report viewer Data menu, choose Subtotals. The Subtotals dialog box opens.
3. From the Definition tab, select an aggregation type to be applied as subtotal data to the report.
4. (Optional step). Click **Advanced** to customize subtotal aggregation by using existing metric data. The system displays the Advanced Subtotals Options dialog box, on which from which you can select an existing metric.

5. (Optional step). Click **Clear All** to discard existing subtotal data.

6. From the **Display Options** tab, select the position for subtotal data display on the report.

7. Click **OK** to save the Subtotals data you have just entered.

---

**Export a report to MS Access**

**Steps**

1. Run a report.

2. From the report viewer **Data** menu, choose **Export Options**. The **Export Options** dialog box opens.

3. Select **MS Access Database** from the **Application** drop-down menu. The options for exporting the report to Access are displayed.

4. Enter display preferences, destination specification, and applicable macro-related information.

5. Click **Advanced Options** if you wish to specify appending, overwrite, and error-handling conditions to the export request.

6. Click **OK**.

---

**Export a report to an MS Excel Worksheet**

**Steps**

1. Run a report.

2. From the report viewer **Data** menu, choose **Export Options**. The **Export Options** dialog box opens.

3. Select **MS Excel Worksheet** from the **Application** drop-down menu. The options for exporting the report to Excel are displayed.

4. Enter display preferences, destination specification, and applicable macro-related information.

5. Click **Advanced Options** if you wish to specify additional display conditions, formatting options, error-handling conditions, and relative worksheet location to the export request.
6. Click OK.

Export a report to an HTML file

Steps
1. Run a report.
2. From the report viewer Data menu, choose Export Options. The Export Options dialog box opens.
3. Select HTML file from the Application drop-down menu. The options for exporting the report to an HTML file are displayed.
4. Enter display preferences, destination specification, and applicable macro-related information.
5. Click Advanced Options if you wish to specify additional filter display, header, SQL viewing, and formatting preferences.
6. Click OK.

Export a report to a text file

Steps
1. Run a report.
2. From the report viewer Data menu, choose Export Options. The Export Options dialog box opens.
3. Select Text File from the Application drop-down menu. The options for exporting the report to a text file are displayed.
4. Enter display preferences, destination specification, and applicable macro-related information.
5. Click Advanced Options if you wish to specify additional filter display, header, SQL viewing, and formatting preferences.
6. Click OK.
Export a report to MS Word

Steps
1. Run a report.
2. From the report viewer Data menu, choose Export Options. The Export Options dialog box opens.
3. Select MS Word Document from the Application drop-down menu. The options for exporting the report to MS Word are displayed.
4. Enter display preferences, destination specification, and applicable macro-related information.
5. Click Advanced Options if you wish to specify additional filter display, header, SQL viewing, formatting, and error-handling preferences.
6. Click OK.

Refresh a report

Steps
1. Run a report.
2. From the report viewer View menu, choose Refresh Report.

Restore metric defaults

Steps
1. Run a report.
2. From the report viewer Data menu, choose Report Data Options. The Report Data Options dialog box opens.
3. From the Join Type tab, click Restore Metric Defaults.

Set an attribute to use its default form in a report

Steps
1. Run a report.
2. From the Report Viewer Data menu, choose Attribute Display. The Attribute Display dialog box opens.

3. From the Attribute box, select the desired attribute, and select Use attribute’s default forms.

4. Click OK.

Set drilling options for a report

Steps

1. Run a report.

2. From the Data menu, choose Report Data Options. The Report Data Options dialog box is displayed.

3. Select the Drilling tab. The Drilling dialog is displayed.

4. Specify your choices from drill handling:
   ◊ uncheck the Enable report drilling box if you want to disable drilling for the report (the box is checked as a default)
   ◊ click the appropriate button to specify whether drilling is to be enabled anywhere or down only
   ◊ check the Keep parent while drilling box if you want to display the level immediately above for the attribute on which you are drilling (the box is unchecked as a default)

5. Click OK when you are done.

Set the evaluation order for a report

Steps

1. Run a report.


4. Click the desired row under Evaluation Order to change the evaluation order.

5. Click OK.
Set the metric formatting properties for a report

**Steps**

1. Run a report in grid view.
2. From the Report Viewer Grid menu, choose Metric Properties.
3. Select the options you wish to apply to the metrics, and click OK.

Set the report limit for a report

**Steps**

1. Run a report.
2. From the Data menu, choose Report Data Options.
4. Double-click in the Definition area of the editor. The Add Qualification dialog box opens.
5. Select Metric Qualification, then click OK. The Metric Qualification (Choose a Metric) dialog box opens.
6. You can add a metric to the Metric box in one of the following ways:
   ◊ Type in the metric’s name: In the Metric box, type in the desired metric name. Click OK. A new Metric Qualification dialog box opens.
   ◊ Browse for the metric: Click the browse button. The Open dialog box opens. Navigate to the desired metric’s location. Click OK. A new Metric Qualification dialog box opens.
   ◊ Drag and drop a metric: From the Object Browser pane, navigate to the metric’s location. Drag the metric into the Metric box. A new Metric Qualification dialog box opens.
7. In the Function box, select either Metric Value, Rank, or Percent.
8. From the Operator box, choose an operator.
9. From the Value box, select value, simple prompt, or expression. Enter an expression or value in the box, or complete the simple prompt definition.
10. Click OK.
11. To save and name your new report limit, from the File menu, click Save.
Show filter details for a report

**Steps**

1. Run a report.
2. From the View menu, select Show Filter Details. The Filter Details box appears at the top of the report.

Show pages for a report

**Steps**

1. Run a report.
2. From the Report Viewer View menu, select Show Pages. The Drop Page Fields Here box opens at the top of the report.
Add a filter dynamically to a report

Steps
1. Run a report.
2. In the Folder List, locate the filter you wish to apply to the report.
3. Drag and drop the filter onto the open report. The report is reexecuted with the new filter.

Clear the sorts for a report

Steps
1. Open the report in the Report Editor.
2. From the Data menu choose Clear Sorts.

Display outline results for a report

Steps
1. Run a report.
2. From the Report Viewer Grid menu, choose Display Outline Results.
Drill on a report

**Steps**

1. Run a report.
2. From the Report Viewer Data menu, choose Drill.
3. In the **Selected object** box, select the object you wish to drill.
4. In the **Drilling options** list, click + next to the desired drilling direction.
5. Click + next to an attribute to reveal a list of elements. Select the element you want to drill to.
6. To keep the parent, select **Keep parent**.
7. Click OK. A new report is generated.

Lock report column headers

**Steps**

1. Run a report.
2. From the Report Viewer Grid menu, choose **Lock Column Headers**.

Lock report row headers

**Steps**

1. Run a report.
2. From the Report Viewer Grid menu, choose **Lock Row Headers**.

Merge header cells on a report

**Steps**

1. Run a report.
2. From the Report Viewer Grid menu, choose **Merge Header Cells**.
Move a column to a page in a report

Steps

1. Run a report.
2. Select a column header.
3. From the Grid menu, choose Move to Page.

Note: To see the column as a page, you must have pages enabled. To enable pages, from the View menu, choose Show Pages.

Move a column to a row in a report

Steps

1. Run a report.
2. Select a column header.
3. From the Grid menu, choose Move to Row.

Move a column to the left in a report

Steps

1. Run a report.
2. Select a column header.
3. From the Grid menu, choose Move Left.

Move a row to a column in a report

Steps

1. Run a report.
2. Select a row header.
3. From the Grid menu, choose Move to Column.

Move a row to a page in a report

Steps

1. Run a report.
2. Select a row header.
3. From the Grid menu, choose Move to Page.

Note: To see the row as a page, you must have pages enabled. To enable pages, choose Show Pages from the View menu.

Select a graph type for a graph report

Steps

1. Select View from the Report Viewer menu bar on a displayed grid report, and click Graph View. The system displays the report in graph format.
2. Select Gallery from the graph report menu bar, and choose the graph format you want to use for the report.

Select an auto style for a report

Steps

1. Run a report in grid view.
2. From the Report Viewer Grid menu, point to Auto Style Selected, then choose the desired auto style. Note the selected style is identified by a check mark.
Select options for a graph report

Steps

1. Select Graph on the menu bar of a report displayed in Graph mode. The Graph drop-down menu is displayed
2. Select an option from the drop-down menu, as follows:
   ◊ Graph options: to select formatting, labeling, and text choices for an active graph
   ◊ Grids and Scales: for options on axis location, axis labeling, scale manipulation, numerical display, and gridline display
   ◊ Titles and Labels: to add titles, subtitles, and footnotes to a graph
   ◊ 3D Settings: to set an angle for graph display, scroll along all three axes, and zoom in or out
   ◊ Preferences: to select font behavior, scrolling, width-to-height ratios, and web display conditions
   ◊ Formatting: for display of a drop-down menu from which you can select specifics for title, subtitle, and legend fonts
   ◊ Display: for display of a drop-down menu from which you can select whether to display titles, subtitles, legends, and data labels

Select options for a grid report

Steps

1. Select Grid on the menu bar.
2. Select Options from the Grid menu. Report Viewer displays the Grid Options dialog box.
3. Click the General tab to select a banding type and formatting styles for metric headers and values.
4. Click the Display tab to select column width, text behavior, and outline mode options.
Sort a report

Steps

1. Run a report.
2. From the Report Viewer Data menu, choose Advanced Sorting. The Sorting dialog box opens.
3. Select either the Rows tab or the Columns tab, and click Add in the desired section. One of the objects from the report appears under Row (or Column) sorts. Click Add again to add another row or column to sort by. For example, if you wish to sort by three objects, click Add three times.
4. To change the object listed in a Sort by cell, click in the cell. A drop down list box appears. From the list, select the object you wish to sort by.
5. To change the criteria, click in the cell. A drop down list box appears. From the list, select the criteria you wish to sort by.
6. If you have more than one object listed under Sort by, the up and down arrows become active. Under Row or Column sorts, highlight a row and click the up or down arrow to move it up or down in the table.
7. To remove an object from the Row or Column sorts, select the object and click Remove.

Once the sort order is defined to your satisfaction, click OK.

View long names in a report

Steps

1. Run a grid report.
2. From the Report Viewer Grid menu, choose Long Names.
Appendixes

Topics included in this section:

• Available Graph Types
Available Graph Types

The following are samples of the graph report types available as options from the Report Viewer menu.

Vertical Area - absolute

Vertical Area - stacked
Appendix A Available Graph Types

- Vertical Area - bipolar
- Vertical Area - bipolar stacked
- Vertical Area - dual axis absolute
Vertical Area - dual axis stacked

Vertical Area - percent

Horizontal Area - absolute
Horizontal Area - stacked

Horizontal Area - bipolar absolute

Horizontal Area - bipolar stacked
Horizontal Area - dual axis absolute

Horizontal Area - dual axis stacked

Horizontal Area - percent
Vertical Bar - side by side

Vertical Bar - stacked

Vertical Bar - dual axis side by side
Vertical Bar - dual axis stacked

Vertical Bar - bipolar side by side

Vertical Bar - bipolar stacked
Appendix A Available Graph Types

Vertical Bar - percent

Horizontal Bar - side by side

Horizontal Bar - stacked
Horizontal Bar - dual axis side by side

Horizontal Bar - dual axis stacked

Horizontal Bar - bipolar side by side
Horizontal Bar - bipolar stacked

Horizontal Bar - percent

Vertical Line - absolute
Vertical Line - stacked

Vertical Line - bipolar absolute

Vertical Line - bipolar stacked
Vertical Line - dual axis absolute

Vertical Line - dual axis stacked

Vertical Line - percent
Horizontal Line - absolute

Horizontal Line - stacked

Horizontal Line - bipolar absolute
Appendix A  Available Graph Types

Horizontal Line - bipolar stacked

Horizontal Line - dual axis absolute

Horizontal Line - dual axis stacked
Vertical Line - percent

Pie - basic

Pie - ring
Appendix A Available Graph Types

Pie - multiple

Pie - multiple ring

Pie - multiple proportional
Pie - multiple proportional ring

Pie - bar

Pie - ring bar
Appendix A Available Graph Types

- Scatter - X-Y
- Scatter - dual axis X-Y
- Scatter - X-Y with labels
Scatter - dual axis X-Y with labels

Polar - coordinate

Polar - dual axis coordinate
Appendix A: Available Graph Types

- Radar - line
- Radar - stacked area
- Radar - dual axis line
Radar - dual axis stacked area

Bubble - basic

Bubble - dual axis
HiLo Stock - basic

HiLo Stock - dual axis

HiLo Stock - open
HiLo Stock - dual axis open

HiLo Stock - open/close

HiLo Stock - dual axis open/close
Histogram - vertical

Histogram - horizontal

3D Riser - bar
3D Riser - pyramid

3D Riser - octagon

3D Riser - cut-corner bar
88 Appendix A Available Graph Types

3D Floating - cube

3D Floating - sphere

3D Connect Group - area
3D Connect Group - ribbon

3D Connect Group - step

3D Connect Series - area
Appendix A Available Graph Types

3D Connect Series - ribbon

3D Connect Series - step

3D Surface - side
3D Surface - honeycomb

3D Honeycomb Surface

3D Scatter - X-Y-Z
3D Scatter X-Y-Z with labels
Index

A
adding a filter to a report 8, 55
All Attributes in a Hierarchy prompts 33
answering a prompt 8, 18
Attribute Qualification prompts 32
auto styles 10
available types of graph report 63

B
banding 4

C
clearing report sorts 55
controlling data levels 4
copyright ii
customizing reports
  answering a prompt 18
data options 15
drilling 18
evaluation order 17
filter detail display 14
functions available 13
inner joins 16
join types 15, 16, 17
metric aliases 18
outer joins 16
page by function 13
report limits 15
resolving prompts 16
schedules 18, 19
using totals and subtotals 15

D
data
  content in grid reports 3
display in graph reports 5
options in a report 15
Data menu, Report Viewer 25
design view reports
  access restrictions 6
definition 6
displaying 44
display area, Report Viewer 24
displaying
data labels for a graph report 37
design view reports 44
filter details 14
footnotes on graph reports 37
graph report titles 38, 44
graph reports 45
grid reports 45
long names 12
outlines on a report 55
SQL view reports 45
subtitles on graph reports 38
drilling 18
down 8
free 8
on a report 56
up 8

E
Element List prompts 32
evaluation order in reports 17
exporting report data 4

F
flipping (pivoting) rows and columns 7, 57
formatting graph reports
  background 39
footnotes 39
frames 39
titles 40
G

Gallery menu options in graph reports 27
Graph menu, Report Viewer 27
graph reports
  background 39
  data display options 5
  data labels 37
  definition 5
displaying 45
footnotes 37, 39
formatting titles 40
frames 39
Gallery menu options 27
legends 37
subtitles 38
titles 38, 44
types available 63
Grid menu, Report Viewer 26
grid reports
  banding 4
  content data types 3
  controlling data display 4
controlling data levels 4
definition 3
  displaying 45
  exporting data 4
  modifying the appearance of 41
page setup window 43

I

inner joins 16

L

legend display on graph reports 37
locking row and column headers 10, 56

M

menu bar, Report Viewer 25
merging headers within a report 11, 56
metric aliases 18
Metric Qualification prompts 33
metrics
  report limits 48
modifying the appearance of grid reports 41
moving rows and columns to a report page 57, 58
moving rows and columns within a report 57

O

Object Qualification prompts
  description 34
outer joins 16
outline mode 9

P

page by 13
page setup window in grid reports 43
prompt resolution 16
Prompt Resolution Wizard
  access 31
  attribute qualification 32
  attributes in a hierarchy 33
definition 31
element lists 32
metric qualification 33
object qualification 34
INDEXTASKS 31

R
report limits 15
clear 48
Report Viewer
  access 23
  Data menu 25
  definition 23
  display area 24
  Graph menu 27
  Grid menu 26
  menu bar 24, 25
tasks 23
toolbar 24, 28
toolbar options 29
  View menu 25
reports
  sorting 55

S
scheduling 18, 19
  selecting a graph type for a report 58
  selecting auto styles for reports 58
  selecting options for a grid report 59
  setting join types 16
  sorting data 7, 60
SQL view reports
  data contents 6
description 6
displaying 45

T
totals and subtotals 15

V
View menu, Report Viewer 25
viewing long names on a report 60